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Abstract -- Agricultural monitoring devices are electrically powered, but agricultural areas are broadly spread out geographically 
where electricity supply is not often available, hence the need for solar charger is clear. In this paper polycrystalline silicon solar 
energy cell boards are designed to be controlled through a LM2596 switching regulator modules. Output voltage and charging 
status from a Holzer current sensor are detected by using SCM STC89LE52RC and analogue-to-digital conversion chip ADC0832. 
The collected data are processed and displayed on an LCD screen. Experimental tests show that the charger can be used for 
normal USB charging, real-time voltage and current parameters are displayed on the LCD during charging, at the start and finish 
with interim state of charge indicated through the LED. 
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I. INTRODUCTION 
 

Agricultural monitoring devices are generally inactive, 
the device is in a sleep state most of the time with very 
little power consumption. Solar energy is very rich as a 
renewable source [1,2,3], the use of solar energy for 
agricultural monitoring devices saves electricity and the 
cost of wiring, as well as avoiding the risk of outages 
which can paralyse the system, hence the use of solar 
energy for agricultural monitoring devices is feasible and 
desirable. 
 

II. THE GENERATION PRINCIPLE OF SOLAR 
BATTERY 

 
Sun light is absorbed through the solar panel, solar 

radiation is converted directly or indirectly into electricity 
using the photoelectric effect or photochemical effect [1]. 
Solar cell devices respond to light and convert  the energy 
of sunlight into electrical energy. There are many kinds of 
materials which can produce photovoltaic effect, such as: 
monocrystalline silicon, polycrystalline silicon, 
amorphous silicon, copper indium selenium, gallium 
arsenide power, etc., they have the same basic principles. 
Now on the light power generation process is described 
with crystal silicon as an example [2]. 

Phosphorus can be doped in the P type crystal silicon 
in order to obtain the N type silicon, thus the P-N junction 
is formed. The new hole electron pairs are formed when 
the sun light in the semiconductor P-N junction, the hole 
flow from the N area to P district, electrons flow from the 
P area to N district under the P-N node action of electric 
field, and current is formed when the circuit switched on, 
this is the working principle of the photoelectric effect of 
solar cell. 

When light irradiates the surface of solar cell, silicon 
material absorb a part of photon, the photon energy 
transfer to the silicon atoms, It make the electronic 
transitions become free electrons, the potential difference 
was formed in P-N junctions. When the external circuit is 
switched on, there will be a current flowing through the 
external circuit to produce a certain output power under 
the action of the voltage, the essence of this process is: the 
photon energy conversion into electrical power. 
 

III. DESIGN OF THE HARDWARE 
 

Solar charger schematic diagram shown in Fig.(1).  
  

 
Fig. (1).   Solar charger schematic diagram 

 
It comprises a solar panel, storage battery, USB output 

interface, a voltage stabilizing circuit, SCM(Single Chip 
Microcomputer) minimum system, charge detection 
circuit, liquid crystal display, LED indicator, voice 
broadcast circuit, etc.. 
 
 A. The solar battery panel 
 

The solar battery board is divided into crystalline 
silicon panels, amorphous silicon cell board, chemical 
dyes panels, flexible solar panels. The crystal silicon cell 
plate is divided into single crystal silicon solar panels and 
polycrystalline solar panel. The photoelectric conversion 
efficiency of monocrystalline silicon solar cell is about 
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15%, sturdy and durable, the service life of up to 15 to 25 
years, but the production cost is big,it can not be widely 
used. The production process of polycrystalline silicon 
solar panels are basically the same with single crystal 
silicon solar cell board, the photoelectric conversion 
efficiency is about 12%, the production cost is cheap, the 
material is simple, saving power consumption, the total 
cost of production is relatively low, so from the price, 
polycrystalline silicon solar energy cell board is slightly 
better than the single crystal silicon solar battery board[3]. 
This design uses polycrystalline silicon solar panels. 

Solar panels include toughened glass, EVA (ethylene-
vinyl acetate copolymer), battery plate, back plate, 
aluminium alloy protective laminate, wiring boxes, silica 
gel, etc.. Toughened glass's role is to protect the power 
subject (such as battery piece), require high transmittance 
(more than 91%), super white steel processing. EVA is 
used to bond the fixed glass and power generation 
subjects (such as battery piece), bond package power 
main body and the back plate. The main function of 
battery plate is to generate electric. The backplane is the 
role of sealing, insulation, waterproof (generally used 
TPT, TPE and other materials), it must be resistant to 
aging. Aluminium alloy protective laminate seals play a 
supporting role. The junction box protect the entire power 
system as a current transfer station role. Silica gel is the 
role of the seal, which is used to seal assembly with 
aluminium alloy frame, assembly and wiring box 
junction. 

In order to estimate the parameters of solar 
photovoltaic products, if it is used for 5 hours a day and 
the output power of 100W. First, power consumption is 
calculated every day (including the loss of inverter): if the 
conversion efficiency of the inverter is 90%, when the 
output power is 100W, the output power of the actual  
needs should be:  

 
111%90100 P   (W)                                (1) 

If 5 hours per day is used, then the power 
consumption E is:  

    5555111 E    (Wh)                                    (2) 

Secondly, Solar panel output power: the assumption 
that the daily effective sunshine time is 6 hours, charging 
efficiency and loss during the charging process are 
considered, the actual use of the process of charging the 
solar battery board rate is about 70%, the output power of 
the solar panel: 

  
132%706555 P   (W)                         (3) 

The final choice of charging controller and battery: 
The maximum output current of the 132W solar energy 
cell board is 7.7A, so the charging current of the charge 
controller should be at least 8A.If the 12V battery is used, 
the depth of discharge is 50%, then the capacity of the 
battery should be:  

5.92%5012555 C  (Ah)                     (4) 
 
If 24V battery is selected, then the capacity of the 

battery should be: 
 

3.46%5024555 C  (Ah)                    (5) 
 

Estimation and detection of solar energy cell: the rated 
power output of the solar cell has a relationship with the 
conversion efficiency, the conversion efficiency of the 
battery components per unit area is high, the output power 
is bigger. The conversion efficiency of solar cell is in 
commonly 14～17%, the output power of the battery piece 
per square centimeter is 14～16mW, solar cell module 
output power per square meter is about 120W. The basic 
calculation formula is:  

 
VIP                                                                     (6) 

In formula (6): P indicates power, V indicates voltage, 
I indicates current. 

The use of energy consumption is: 
 
    tPE                                                                 (7) 
In formula (7): E indicates energy consumption, P 

indicates power, t indicates time. 
 

B. The Design of Voltage Stabilizing Circuit 
 

The design of voltage stabilizing circuit shown in 
Fig.(2). 
  

 
Fig.(2) . The voltage stabilizing circuit 

 
Due to the electrical charging part circuit access (USB 

load) moment will have a larger current change, it will 
have a certain impact on the MCU system, in order to 
guarantee the stability of the system, the power of the 
interference to a minimum,  LM2940 is used after 
stabilizing to supply system power separately , LM2940 is 
linear three terminal regulator which have a fixed and low 
voltage output, it compared with LM7805 of the 
traditional ST 78 series voltage stabilizing chip, LM2940 
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have lower voltage difference of input and output, 
conversion efficiency is higher, in good heat dissipation 
condition, rated output current can reach 1A, when the 
output current is 1A, the minimum voltage difference of 
input to output is less than 0.8V; and the maximum input 
voltage is 26V; working temperature is -40 to +125 ; it 
contains static current reduction circuit, current limit, 
overheat protection, reverse connection of power supply 
and load inverse insertion protection circuit, it can be 
protect the safety of controlling circuit effectively when 
the solar battery board reverse connection. 

LM2596 is used in the power supply of charging 
circuit [4], Voltage regulator module LM2596 is launched 
by the United States National Semi-conductor 
Corporation, it is a down voltage switching integrated 
circuit of  3A output current, it contains a fixed frequency 
oscillator (standard is 150kHz) and the reference voltage 
regulator (standard is 1.23V), it have a protection circuit, 
overheat perfect the turn off circuit, current overload 
limit, etc.. The module only needs few peripheral circuit, 
voltage stabilizing circuit can be highly efficient and 
stable. For 5V DC voltage regulator circuit, the short-
circuit current can reach 3A, Schottky diode 1N5824 is 
used for freewheeling diode in circuit, maximum 
continuous current may be to 5A, It also has a 2A margin 
when LM2596 at 3A output current, it can ensure the 
security of the system and the reliability under full load. 
 
 C. SCM Minimum System 
 

Design of SCM minimum system as shown in Fig.(3). 
  

 
Fig.3. SCM minimum system 

 

STC89LE52RC microcontroller of STC technology 
company is used for the main controlling chip ,it is a kind 

of CMOS 8 bit microcontroller with low power 
consumption and high performance, with 8K Flash 
memory in programmable system, using the traditional 
MCS-51 kernel. It has 512 bytes of RAM, 32 I/O ports, 
general watchdog timer, built-in 4kB EEPROM, MAX810 
the special reset circuit, 3 general purpose 16 bit timer / 
counter, 4 external interrupt port, a structure of seven 
level Four interrupt vectors (it is compatible with the 5 
vector 2 level interrupt architecture of traditional 51),a 
full duplex serial port [5].In addition, static logic 
operation of STC89LE52 can be reduced to the lowest 
0Hz,It supports 2 power saving modes through software 
selectable. 

In idle mode, the CPU will stop working and only 
allow RAM, serial port, timer / counter, interrupts to 
work. In the power down protection, the contents of the 
RAM will be saved, the oscillator will be frozen, all work 
of MCU will stop, until the next interrupt or hardware 
reset date of arrival. The maximum operating frequency is 
35MHz. Instruction code is compatible with the tradition 
8051 microcontroller core , the 12 clock / machine cycles 
and 6 clock / machine cycle can be arbitrary choice, the 
MCU adopt 3.3V level format with lower power 
consumption than the traditional 8051 MCU. 

The reset trigger of the MCU requires high level for 
over two cycles , which takes about 2 ~ 3 μs, automatic 
power on reset and manual button reset can be designed , 
the power on reset is the use of capacitor in the just power 
on transient state corresponds to the conduction of the 
properties, the RST pin of MCU to high level, the 
function of 10uF capacitor is slightly prolong the charging 
time of capacitor, the time of high level is more than 30 s, 
and then the capacitor after a full charge equivalent to 
cutoff, The RST pin is connected to ground through the  
10kΩ resistor, it equivalent to connect a low level, so that 
it is equivalent to the RST pin a pulses of high level more 
than 30 s, it make the reset of MCU can be to normal 
work. Need to press the button when manual reset, RST is 
directly connected to the Vcc, loosen the button connected 
to ground through the  10kΩ resistor, it is equivalent a 
low level, the time remained at least more than 100ms 
when the button is pressed (assuming 10 times can be 
pressed per second), this is equivalent to the completion 
of a high level pulse , which makes the MCU can normal 
reset. 

Crystal's role is to produce the original clock 
frequency, numerical of crystal oscillator commonly is 
12MHz and 11.0592MHz. The baud rate formula is:  

)65536(16
2

t
f

B               (8) 

In formula (8): B indicates baud rate, f indicates 
Crystal oscillator frequency, t indicates time. 

If the MCU is connected to a external crystal for 
11.0592MHz,  the baud rate generator is T/C2, the 
calculation result is: 
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2

100592.11
9600

6

t


       (9) 

Calculation formula (9): 
 

xffdct 065500                   (10) 

The obtained t is an integer, transmission error can 
be eliminated, so the design is use of passive 
11.0592MHz crystal. The starting capacitor of crystal 
adopt two 30pf/63V ceramic capacitor . 

 
D. The design of charging circuit 
 

The design of charge detection circuit is shown in 
Fig.(4).  

The parameters of charge state are mainly the terminal 
voltage of solar panel and the charging current value. 
Because the output voltage of polysilicon solar panels has 
a relationship with the light intensity,the light intensity is 
stronger, then the output voltage value is close to the rated 
voltage of the solar battery board,this part of the value can 
reflect the intensity of the light.The charging current 
magnitude response speed of the charging,in the electric 
power controlling range,the output current is greater then 
charge faster, conversely the more slowly [6]. 
  

 
Fig. (4). The charge detection circuit 

 

As a result of the analog-to-digital conversion chip 
ADC0832,it can measure the voltage range is 0 ~ 5V, and 
the output voltage range of the solar battery board is 0 ~ 
12V, so three 15MΩ/0.25W precision carbon film 
resistor is used in the form of series pressure to obtain the 
voltage component , the component is the 1/3 of testing 
voltage value, change the range is 0 ~ 4V,it has solved the 
voltage under test beyond measurement range. 

A new linear current sensor ACS712 module is used 
as a current information collection, the device has a built-
in precision low bias linear Holzer sensor circuit, the 
output voltage proportional to current detection, and with 
characteristics such as low noise, fast response time, 
convenient use, high performance price ratio, etc. The 

module is in series to the circuit being measured when 
used, the output voltage will produce corresponding 
change according to the size of electric current flows. Its 
output voltage of VOUT end is VCC / 2, variation is 185 
mV/A, measuring range is ±5A (reverse current may be 
measurable) in the case of no current flows through.  

ADC0832 is a A/D conversion chip, Resolution is 8 
bit and two channels, it was launched by the American 
national semiconductor Corporation. Analog-to-digital 
conversion chip for 8 bit resolution can be divided the 
reference voltage into 256 digital quantity, the measured 
voltage of input is compared to the voltage of recovery 
approximation method obtained  the digital quantity, VCC 
is used for reference voltage , when using 5V DC power 
supply, its range is 0 to 5V, If the measured voltage is 
more than 5V,You need to test the voltage divider, a 
voltage component is less than 5V, then the actual 
measured voltage is calculated in MCU. Because of its 
input and output level is compatible with TTL/CMOS 
microcontroller, and the data/instruction transmission can 
be used directly. The interface between ADC0832 and 
MCU under normal circumstances should be 4 data lines, 
which are DO, DI, CLK, CS . But because of not 
effective at the same time the DI end and the DO end 
during the communication, and the all interface of MCU 
are bi-directional, the circuit in the design of DO and DI 
can be connected in parallel with a data line. When 
ADC0832 is in the non-working state, the input of CS  
should be high level, the chip is disabled, level of DO/DI 
and CLK can be any value. When converting for A/D is 
needed, you must first will enable CS  end on a low level, 
and the need to maintain a low level until the end of 
conversion chip, at this time to start the trans formation 
work. At this time, the processor input clock signal to the 
clock input of chip, the data signal is selected by the 
DO/DI terminal using the input channel function in DI 
terminal. DI must keep high level at the first falling edge 
of the clock signal, it represents the beginning of the 
signal.2 bit data should be input to the DI end of the 
second and third pulse, it is used to select the channel. 
 
E. Design of voice broadcast circuit 
 

Design of voice broadcast circuit as shown in Fig.(5), 
SYN6288 Chinese speech synthesis module is used. 

SYN6288 Chinese speech synthesis chip is a high-end 
speech synthesis chip [7], it was launched by Beijing 
Yuyin world science and technology limited company. 
SYN628 receives the text to be synthesized through the 
asynchronous serial port, a text to speech (TTS) 
conversion is implemented, Chinese speech synthesis 
effect is clear, natural, accurate; Any specified Chinese 
text and English letters can be synthesized. SYN6288 is a 
built-in push-pull (Push-Pull) DAC, the horn can be 
directly driven voice broadcast without requiring high 
power play.The power amplifier circuit can also be 
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designed, the speaker is driven voice broadcast with 
requiring high power play. 

 

 
Fig. (5). The voice broadcast circuit 

 
 
F. Design of State Display Circuit 
 
Two ways to display the available charge state, one is 
through the LCD screen for various parameters (voltage 
and current) to display, the other one is using LED (light-
emitting diode) display. 
Design of LCD12864 circuit as shown in Fig.(6). 
  

 
Fig.(6)  LCD12864 circuit 

 
LCD12864 is a LCD display, the display resolution is 

128× 64, 8192 Chinese characters of 16×16 point is built-
in, and 128 ASCII character of 16 × 8 bit is set. Using the 
interface mode of the module is simple, flexible and 
convenient operation instruction, so a full Chinese man-
machine interactive graphical interface [8] can be 
constituted, parallel port mode can be used for 
transmission of data / instruction data with the 
microcontroller P1 port. 

Design of the LED indicator circuit as shown in 
Fig.(7). 

A red 5mm light emitting diode, a  yellow  5mm light-
emitting diode and a green 5mm light emitting diode are 
used for charging state indication circuit in LED, The 
phenomenon of red LED light and green LED 
extinguished means no charge or abnormal state of charge 
,the phenomenon of green LED light and red LED is 
extinguished means normal charging. 
  

 
 

 
Fig. (7)  LED indicator circuit 

 

Because the SCM can withstand the current irrigation 
co., 500Ω/0.25W current limiting resistor are respectively 
connected in series to prevent excessive current damage 
of MCU in circuit design ,the two LED conduction state 
are controlled by the MCU for detecting the charging 
current.If there is no current in the circuit is that no 
charge,or too large current is that abnormal charging 
(normally the charging current is not more than 2A, if 
more than 2A may have a short circuit), the red LED is 
lighted,if there is a current and the current value is less 
than 1.5A thatis normal charging, green LED is 
lighted.The green light, red light, yellow light end are 
respectively connected with the SCM of P2.0, P2.1, P2.2, 
the others end are connected with power through 
500Ω/0.25W current limiting resistor . 
 

IV. DESIGN OF SOFTWARE 
 

The design of the software includes main program and 
subroutine. The function modules such as LCD liquid 
crystal display module,ADC0832 module, speech 
synthesis chip SYN6288-UART serial communication 
module, LED module, and so on are encapsulated into 
instructions written subroutine, the main program is 
designed according to the need to directly call. The main 
program flow chart as shown in Fig.(8). 

The first to initialize each function module, voltage 
and current loop to read and process data, voice prompt 
the current state, the liquid crystal display the charging 
state parameters, the red, green, yellow LED indicator is 
controlled to light or extinguish. 

Design of liquid crystal display subroutine flow chart 
as shown in Fig. (9). 

Liquid crystal display subroutine to definition of data 
and function interfaces, the D0-D7 data export, RS 
register selection, R/W selection, EN enabled, PSB serial / 
parallel selection, and so on are needed to define .The 
display switch, display mode, the cursor switchand others 
function are initialized, liquid crystal on the work state of 
busy are detected, the SCM can read and write operation 
of liquid crystal in the liquid crystal free. 
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Fig. (8).  The main program flow chart 

 

Design the voice of the subprogram flow chart shown 
in Fig.(10) . 

The serial port function is initialized by the speech 
subroutine, the baud rate and busy state detection are set. 
The baud rate is the benchmark rate of serial 
communication, the same baud rate must be have between 
the equipment  in using the serial communication, data 
can be synchronized, the baud rate is the frequency signal 
generated by the timing function of timer / counter T/C1. 
Detection of busy, because of a speech synthesis module 
if you are playing the voice unable to receive new 
instructions or data, only when the busy state after the end 
the new instruction and data can be received and handled 
[10]. 
According to the flow chart, it is compiled on the KEIL 
IDE Vision4 platform with the C programming language 
[11].  

 
 
 
 
 

 
Fig.(9)  liquid crystal display subroutine flow chart 

 

 
Fig. (10)  The voice of the subprogram flow chart 
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V. SOFTWARE COMPILATION AND DOWNLOAD 
 
KEIL IDE Vision4 compilation process is: 
(1) StartμVision4-IDE, KEIL software integrated 
development environment is entered, the "Project→ New 
Project..." Menu is selected, a directory is selected or 
created for the New Project in the pop-up "Creat New 
Project" dialog box, and the name of the Project file is 
input, a Project file (.μv2) is automatically generated. 
Click the "save" button, select the target chip window as 
shown in Fig.(11). 
  

 
Fig. (11)  Select the target chip window 

 
Target CPU is selected in the window, Keil C51 

support a lot of CPU, AT89C51 chip of Atmel company is 
selected, click the "ok" button, a dialog box asked if the 
standard AT89C51 boot file is chosen and added the 
project, click "yes" button, it will join the rest of the 
project file.  

Return to the main window, "Target1" is appeared in 
the project window file page, there is the "+" in front. 
Click the "+", you can see the next layer of "Source 
Group1", then click the "+" in the "Source" Group1, you 
can see a STARTUP. A51 file. This file is just to join, it is 
suitable for most AT89C51 derived series startup file 
code. Startup code is executed first starting target chip 
code in main () function before, it is used to remove data 
memory, hardware initialization, again into the stack 
pointer.  

"File→ New..." is selected, a new file input window is 
opened on the right side of the project manager, the 
source program is input in this window, letter of 
uppercase and lowercase letter and the semicolon after 
each row is noticed, don't lose and leakage input wrong.  

After the input, "File→ Save" is selected, the File is 
named and saved. You must add extension, the name of 
this design using C language, so the extension is ".c", here 
it is named "mms. c", if the program is written in 
assembly language, the extension is the ".asm". After the 
file is saved, the window can be closed.  

    Then need to manually add source program to the 
project, click on the "Source Group1", make its reverse 
display, and then click the right mouse button, a shortcut 
menu appears, the Add file Group "and" Source Group1 
"is selected, a dialog box appears, it is asked to find the 
source file. Double-click the mms. c file, the file is added 
to the project. Note that after the file is to join the project, 

the dialog does not disappear, waiting for continue to add 
other documents. At this point, click the "Close" to return 
to the main window, after the return, click the plus sign in 
front of "Source Group1", mms. c file is in it, double-click 
the file name, the source program has been opened.  

(2) The project Settings  
After building project, further engineering is set to 

meet the requirements. Double-click the Project window 
"Target1" first, and then click the right mouse button, the 
"Project→ Option for target" and "Target1"are selected 
from the shortcut menu, Project Settings dialog box 
appears. This dialog has 10 pages, including the driver 
pages, target pages, output pages, a list of pages, C51 
pages, A51 pages, BL51Locate pages, BL51Misc, 
debugging and utility pages, most of items is set by 
default.  

(3) Compile and link  
After project settings, it can be compiled and links. 

Menu "Project → Build target" are selected, the current 
engineering is connected, if the current file has been 
modified, it will be to compile the file first, and then be 
connected to generate the target code; If the "Rebuild All 
target files" is selected, it will recompile all the files in the 
current project, and then be connected, the goal of 
eventually produce code is to ensure that the latest; The 
"Translate..." item is compiled only the current file, don't 
connect. The above operations can also be directly via the 
toolbar button, from left to right are: compiling, compile 
link, all the reconstruction, stop compiling, download to 
Flash Memory and to set up the project.  

Compile information will appear in the output window 
in the process of the Build page, compile results display 
window as shown in Fig.(12).  
  

 
Fig. (12)   Compile results display window 

 
If the source has grammatical errors in the program, 

there will be a bug report, double-click on the bank, the 
location of the error can be positioning, compile again 
after the source program to modify, until the error is 0. At 
the same time, the amount of code of the program, 
internal RAM usage, external RAM usage information 
and so on can be seen in the window. In addition, compile 
and link also have some other relevant documents, 
including the relocatable object files (.obj), relocatable 
file list. (.lst), an absolute address the target file (no 
suffix), an absolute address list file (. m51), connecting 
the input file (.inp), these can be used for simulation and 
debugging of Keil C51 to start debugging after this step.  

Press Ctrl+F5 key combination or use the menu 
"Debug→ Start/Stop the Debug Session" can be entered 
into a state of debugging. Most of the command on the 
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Debug menu can be found corresponding shortcut button 
in the run and Debug toolbar. Generally from left to right 
in turn is reset, running, pause, single step, process step, 
the execution of the current subroutine, run to the current 
line, the next state, to open the tracking, observation, the 
disassembly window, observation window, code analysis, 
1# serial window, memory window, performance 
analysis, tool button command window. After debugging 
success under the interface block diagram shows "0 Error 
(s)". 

(4) Software download 
Download software used on STC official download 

software, the target file is directly open after the port is 
selected, and then click download, and the MCU with 
electricity, software download can be completed. Program 
download interface as shown in Fig.(13). If the download 
is successful, the "operation is successful!” will be 
displayed in the lower right corner block diagram.  
  

 
Fig.(13)  Program download interface 

 
 

VI. THE EXPERIMENTAL RESULTS 
 

All unit circuit are simulated on the Proteus platform, 
the PCB board is designed and produced after simulation, 
the MCU of download the program and other components 
are welded on the PCB board [12], physical diagram is 
shown in Fig.(14). power on, the function is test. 

LCD display voltage and weak current at no charge. 
Insert the USB load or connect the battery, the LCD 
screen display voltage and large current after charging 
starts, After start charging LCD display is shown in 
Fig.(15), and the voice prompt "start charging". The LCD 
screen display voltage and small current end of charging 
or pull out the USB load, and the voice prompt "end of 
charge". Testing the 10V solar panels solar panels, 
terminal voltage 9.76V is displayed without charging, the 
charging current is 0.02A, the yellow indicator light. 
When entering the state of charge USB load insertion or 
connect the battery, solar battery board terminal voltage is 
displayed 8.94V, the charging current is 0.45A, the green 
indicator light is on, the voice prompt “start charging”, the 
system enters the state of charge. When charging is 

completed or USB load after pulling out ，the display 
content return when charging state, the red indicator light 
is on, the voice prompts “the end of charging”, not into 
the state of charge. 
  

 
Fig. (14)  Physical diagram 

 

 
Fig. (15 )  After start charging LCD display 

 
 

VII. CONCLUSIONS 
 

Solar energy is a very abundant renewable resource, it 
has a very broad practical prospect. Solar charger design 
not only can be used for agricultural monitoring devices, 
but also with appropriate transformation can be applied to 
many electric chargers used in daily life, such as mobile 
phone, digital camera, MP3 player, a tablet computer, etc. 
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